
 PhoneCode Help
Help is available on a number of topics in PhoneCode.    Select the help you need from the list below, or 
you may use the search feature of help to quickly look up the help you need.

Overview

About PhoneCode

What is PhoneCode

Registering PhoneCode

Using PhoneCode

Commands

Parts of Windows

Procedures

Questions and Problems



What is PhoneCode

PhoneCode is a program allowing a person to find information about area codes, time zones, and major 
cities for the United States and Canada.    After Setting Up PhoneCode, you may search the data base 
by area code or city and state, then the matching data is displayed on the Main Form.    Some of the 
data displayed includes:

The selected area code

The selected city and state (or province)

Region of the selected area code

Home time and the selected region time

The difference between the times

Major cities in the selected area code

Once the data is retrieved, it may be printed if desired.

See Also

Select by AreaCode

Select by City

Printing the Data



About PhoneCode

PhoneCode is a written in Microsoft Visual Basic.    It is a shareware program.    The shareware version 
may be distributed according to the limited license.    The registered version may not be distributed.    
Please send all question, problems, or comments on PhoneCode to:

Dan Begallie

621 Griffith Road

Akron, OH    44312



Parts of Windows
There are two major windows in PhoneCode, the Main window where most of the data is displayed, and 
the Setup window where the program can be configured.    Most of the program can be run from the 
Main window.

Parts of the Main Window

Parts of the Setup Window



Commands

PhoneCode supports both mouse and keyboard input.    You may use either to make your selections in 
the program.    For more direct help select the method of input you are using from the choices below.

Keyboard

Menu Commands

Mouse



Procedures

Some common procedures in PhoneCode are listed below.    You may choose the one for more 
information and help on it.

Changing the Home City

Changing the Home Time Zone

Exiting PhoneCode

Hiding/Showing the Major Cities List

Hiding/Showing the Time Data

Printing the Data

Registering PhoneCode

Selecting by Area Code

Selecting by City

Setting Up PhoneCode



Questions & Problems

Here are some of the more common problems and questions about PhoneCode:

Can I Add More Data?

How do I register PhoneCode?

I Can Think of Some Improvements

I Get a Missing File Error

My Home City is not Listed

My Home Area Code is Wrong

My Home Time Zone is Wrong

PhoneCode Will not Print

What Do the '*' and '#' Symbols Mean?



Parts of Main Window

Menu -

The pull down menus contain many of the program features and options.    These menus may be 
accessed by the keyboard or the mouse.

Major Cities List -

The Major Cities List contains the up to five of the larger cities located in the selected area code.    A city 
preceded by an asterisk (*) means to subtract one hour from the regional time displayed.    A city 
preceded by a pound sign (#) means to add one hour.

Information Box -

The Information box displays the data from the area code search.    It cannot be changed except by the 
program.    Here you will find the searched area code, the state or province it's located in, the region of 
the state or province, the regional time, the local time, and the time difference.

Select Buttons -

This part of the window contains the command buttons used to select and display the data.

Status Bar -

The Status Bar displays the home data.    This includes the home area code, time zone, city and state.

See Also

Hide/Show the Major Cities Box

Menu Commands

Selecting By Area Code

Selecting By City



Parts of Setup Window

Information Box

When a valid home city and state (or province) are selected, the home data from the selection is 
displayed in the box.    The data here cannot be changed except by selecting a new home city or by 
overriding the data using the override time zone and override city buttons.

Display Options

These check boxes control the default options of the program.    If the Show Cities box is checked, the 
program will start showing the major cities list.    If the Show Time box is checked, the program will 
default to showing the time with each selection.

Select New Button

This button brings up the city & state selection window.    The user can then set the home data for the 
program by selecting a valid city and state from the list.    When the selection is correct, the Save Setup 
button will store the data and make the program changes.

Save Setup Button

This button may be selected once valid data is in the Information Box.    It stores the changes in the 
program INI file, exits the setup mode and returns program control to the main window.

Override Buttons

The Override City and Override Time Zone buttons allow the user to change the home data for either the 
home city or home time zone.    This is useful if the city you live in is not listed, or if the time zone you live 
in is different from the one selected by the program.

Help Button

The Help button will bring up this PhoneCode Help.

Abort Button

The Abort button will cancel all changes made, restore the original data, and return program control back 
to the main window.

See Also

Changing Your Home City



Changing Your Home Time Zone

Hiding/Showing the Major Cities Box

Hiding/Showing the Time Data

Setting Up PhoneCode



Mouse Commands

Main Window Buttons    

Select By AC

Select By City

Hide/Show Cities

Setup Window Buttons    

Select New

Save Setup

Override City

Override Time Zone

Help

Abort

See Also

Menu Commands

Keyboard Commands



Keyboard Commands

Main Window Commands

Select By AC     ALT - A 

Select By City     ALT - I

Hide/Show Cities     ALT - C

Setup Window Commands

Select New     ALT - N

Save Setup     ALT - S

Override City     ALT - O

Override Time Zone                                    ALT - T

Help     SHIFT F1

Abort         ALT - A

See Also

Menu Commands



Menu Commands

File Menu

Select By AC            ALT - F, A                            CTR - A

Select By City      ALT - F, I CTR - I

Setup ALT - F, S CTR - S

Save Options      ALT - F, V

Print DataALT - F, P CTR - P

Exit ALT - F, X CTR - X

Options Menu

Show Cities          ALT - O, C                          CTR - C

Show Time                ALT - O, T                          CTR - T

RegisterALT - O, R  

Help Menu

Contents            ALT - H, C                        SHIFT F1

KeyboardALT - H, K

Mouse ALT - H, M

About ALT - H, A



Select By Area Code

When selecting this choice, an input box will appear prompting you to enter a valid area code.    When a 
valid area code is entered, PhoneCode searches its data for the requested information, which is then 
displayed in the information box on the Main window. The Abort button will cancel the request and return 
you back.    If an incorrect area code is entered, an error message will be displayed.

See Also

Selecting By City



Select By City & State

When selecting this choice, the Select by City window will appear.    Here you may enter the city and 
state or province you wish to find the data on.    First you will need to select a state or province from the 
combo box.    When that is selected, a list of valid cities will appear in the city list box.    Select the city 
from this box by using the arrow keys and pressing OK, or by double clicking on it with the mouse.    
When selected, the information will appear on the Main window.    The Abort button will cancel the 
request and return you back.

See Also

Selecting By Area Code

The "*" and "#" Symbols



Setting Up PhoneCode

Overview

Before PhoneCode can be run, it needs to know where to base its time zone calculations from.    The first 
time the program is run, you will be prompted to enter the home city and state.    The Setup window will 
appear, followed by the Select Home City window.

Selecting Home City

From the combo box on the Select Home City window you need to select a valid state or province.    
Next, select a city from those shown in the list box.    If the city you live in is not supported by the 
program, you can use the Override City button to enter your actual city.    When you have selected a city 
from the list box, you may either double click on it with the mouse or select the OK button.

Overriding Home Time Zone

For some cities, the selected time zone may be incorrect.    This occurs when the area code boundaries 
fall within more than one time zone.    If this is the case for your city, you may select the Override Time 
Zone button to correct the situation.

Selection Options

From the Setup window you may select one or both of the display options, Show Cities or Show Time.

Saving Changes

When the shown in the information box is correct, you may select the Save Setup button.    This will save 
the current configuration as the default, and write the changes to the programs .ini file.

See Also

Changing Your Home City

Changing Your Home Time Zone

Questions & Problems

Registering PhoneCode



Overriding Home City

If your city is not supported by PhoneCode, you are given the option to override the selected city with 
any city name of your choice.    From the Setup window select the Override City button.    This brings up 
a text box with the name of the current city.    Enter in the text box the name of the city you wish to have 
instead, the select the OK button.    Your new city will now appear in the information box on the Setup 
window and the Status Bar of the Main window.

See Also

Setting Up PhoneCode



Overriding Home Time Zone

Because an area code boundary may fall in more than one time zone, PhoneCode allows you to change 
the home time zone if necessary.    From the Setup window select the Override Time Zone button.    This 
brings up a list box    with the names of the supported time zones.    Select from the list box the correct 
time zone and select the OK button.    Your new time zone will now appear in the information box on the 
Setup window and the Status Bar of the Main window.

See Also

Setting Up PhoneCode



Exiting PhoneCode

PhoneCode may be exited by selecting the Exit option from the File Menu of the Main window.    
PhoneCode will save the current screen position of the window so that it appears in the same spot next 
time it is run.



Hide/Show the Major City List

The Major City list box shows up to five of the cities in the selected area code.    It may be hidden from 
view if desired.    This option may be toggled by using the Hide(Show) Cities button or from the Options 
menu on the    Main window, or by checking the Show Cities check box from the Setup window.

See Also

Menu Commands

The "*" and "#" Symbols

Setting Up PhoneCode

Show Cities



Hide/Show Time Data

One of the features of PhoneCode is to display the time difference between the home area code and the 
selected area code.    When the time data feature is turned on, the information box on the Main window 
will show the home time, regional time, and the difference between the two, each time a new area code 
is selected.

See Also

Show Time



Show Cities

From Option Menu

This will immediately toggle the display of the Major Cities box on the    Main window. 

From Setup Window

Selecting this check box will change the default status of whether the Major Cities box is displayed.    If 
the box is checked the Major Cities box will be displayed upon program startup, if the check box is left 
unchecked, the Major Cities box will not be displayed when the program is run.

See Also

Hide/Show the Major Cities List

Menu Commands

Saving Setup



Show Time

From Option Menu

This will toggle the display of the time information in the information box on the    Main window.    When 
checked, the time will update with the next selection.

From Setup Window

Selecting this check box will change the default status of whether the time information is displayed.    If 
the box is checked the time information will be displayed upon program startup, if the check box is left 
unchecked, the time information will not be displayed when the program is run.

See Also

Hide/Show Time Data

Menu Commands

Saving Setup



Printing Data

Selecting the Print Data option from the File menu on the Main window will allow you to print a hard copy 
of the data shown in the information box.    The printed data will appear in this format:

Area Code :    216

State :    Ohio

Region :    North East Ohio

Major Cities : Akron, OH

Canton, OH

Cleveland, OH

Kent, OH

Youngstown, OH

See Also

PhoneCode Will Not Print



Saving Setup

When this choice is selected from the File menu of the Main window. or the Save Setup button of the 
Setup window, PhoneCode writes a new .ini file saving the current data and options

See Also

Show Cities

Show Time

Setting Up PhoneCode



The "*" and "#" Symbols

The asterisk (*) or pound (#) sign might appear before a city in the Major Cities List or when selecting by 
city.    Because an area code may fall within the boundaries of more than one time zone, these symbols 
mean either to subtract one hour from the regional time for this city if the city is preceded by the asterisk 
(*), or to add one hour if the city is preceded by the pound (#) sign.



PhoneCode Will Not Print

PhoneCode will try to print using the following fonts in this order: Arial, Helv, System.    If one of these 
fonts is not installed by Windows, PhoneCode will not be able to print.

See Also

Printing Data



Missing File Error

PhoneCode requires information stored in a few data files to bring up the information requested.    If    
these data files get erased or corrupted, a missing file error will appear, and PhoneCode will end.    If this 
happens, re-install PhoneCode using the setup program.    When this is done, PhoneCode will have to 
be re-configured just like the first time it was used.

See Also

Setting Up PhoneCode



Comments and Suggestions

Any comments and suggestions are welcome and can be sent to the following address:

dB Software

621 Griffith Road

Akron, OH    44312



Adding & Changing Data

At the present time, more data may not be added to the PhoneCode data files.    Any more than the first 
five cities will be ignored.    It is possible to edit the data to include often called cities.    To do so, use a 
text editor to edit the file CITYAC.DAT, and change the name of one of the cities next to the matching 
area code to whatever city you wish. 

Note:    It is not recommended to change the other .DAT files.



Select New

Selecting this button will allow you to enter a new home city.    It will bring up the Select Home City 
window, where you can select the new city.    This only has to be done if you change locals or need the 
data from a different home city.

See Also

Changing Your Home City

Setting Up PhoneCode



Help Button

This Button will bring up this help files table of contents.    You can also use the F1 function key to get 
context sensitive help throughout the program

See Also

About Help

Contents Help

Keyboard Help

Mouse Help



About Help

This selection from the Main windows Help menu will bring up the about screen.    The about screen 
contains program information, the programs serial number, and some environmental data.

See Also

Contents Help

Keyboard Help

Mouse Help



Contents Help

This selection from the Main windows Help menu will bring up the help files table of contents.    You can 
use the table of contents to quickly help you find the topic you need help on.

See Also

About Help

Keyboard Help

Mouse Help



Keyboard Help

This selection from the Main windows Help menu will bring up the keyboard help section.    Here you can 
get information on any of the shortcut keys used throughout the program.

See Also

About Help

Contents Help

Mouse Help



Mouse Help

This selection from the Main windows Help menu will bring up the mouse help section.    Here you can 
get information on some of the buttons used throughout the program.

See Also

About Help

Contents Help

Keyboard Help



Abort Button

The Abort button will cancel all changes made and return you to the previous window.



Regional Time

The current time in the selected area code.



Home Data

Information about the current home area code.    This information includes the home city, home state, 
home area code, and home time zone.



Valid Area Code

Any area code in the United States or Canada. (including Alaska and Hawaii)



Registering PhoneCode

The registration screen will appear the first time PhoneCode is run, or when Register is selected from 
the Options menu.    It is from this screen that you may register PhoneCode with your Name, Company, 
and registration number.    If you have not registered PhoneCode, you may select the Enter Later button. 
You can then register the program at a later time by selecting Register from the Option menu.    The 
screen will only appear the first time you run PhoneCode.    When PhoneCode is registered, the Register 
selection will dissapear from the Options menu. 

See Also

How to Register PhoneCode



How to Register PhoneCode

If you decide to keep PhoneCode over 30 days, you are required to register the program.    Instructions 
on registering PhoneCode may be found in the file ORDERFRM.WRI. 

See Also

Registering PhoneCode


